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Module 1 - Introduction to Linux

Module 1 - Introduction to
Linux

Exercise Manual

Complete the following exercises as directed by
your instructor.

Exercise 1: Describe Linux and Open Source

Exercise 2: Define the Business Reasons for Linux

Feedback

E-mail training @novell.com with the following:

Subject: Bridging NetWare to Linux Module 1
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Exercise 1 Describe Linux and Open Source

Complete the following:

1. Read the article Linux: The “Other” Operating
System.

http://support.novell.com/techcenter/articles/an
a20030701.html

2. Answer the question: What is Linux?

3. Answer the question: What is Open Source?

4. Goto http://www.opensource.org and review the
definition for open source software.
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Describe Linux and Open Source

5. What is Novell’s main product for workgroup
computing?

(End of Exercise)
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Exercise 2 Define the Business Reasons for
Linux

Many network administrators are asked to justify
their decisions for recommending a particular
software product over others.

The purpose of this exercise is to broaden your
knowledge around the business reasons for
selecting Linux.

Complete the following:

1. Read the 10 reasons to choose Novell for Linux.
http://www.novell.com/linux/whynovell/index.html
2. Review the article on how Novell is jump

starting Linux in the small and medium business
world.

http://www.novell.com/linux/pdf/ideasiams051305.
pdf

3. Review the Linux truth web site.

http://www.novell.com/linux/truth/

4. Review the Novell Open Enterprise Server total
cost of ownership paper.

http://www.novell.com/products/openenterpriseserv
er/docs/oes_tco_whitepaper.pdf
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Define the Business Reasons for Linux

5. Review the Novell Open Enterprise Server
product brochure.

http://www.novell.com/products/openenterpriseserv
er/oes_brochure.pdf

6. Review the latest news and reviews on OES.

http://www.novell.com/products/openenterpriseserv
er/oes_news.html

(End of Exercise)
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Module 2- Linux Fundamentals

Exercise Manual

Complete the following exercises.
Exercise 1: Login, Use Linux, and Logout
Exercise 2: Locate and Use Help Resources

Exercise 3: Use the Linux Shell and Command
Line

Exercise 4: Describe and Use Common Linux
Commands

Exercise 5: Understand and View Processes
Exercise 6: Manage Runlevels

Exercise 7: Shut Down and Restart the Server

Feedback

E-mail training @novell.com with the following:

Subject: Bridging NetWare to Linux Module 2
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Exercise 1 Login, Use Linux, and Logout

Prerequisites

= You will need an OES Linux server to perform
these exercises.

If you do not meet this requirement, you may
want to come back and perform this exercise
after installing OES Linux in Module 4.

A VMware 5 virtual machine for Open
Enterprise Server SP1 for Linux from the
course web page.

= If using VMware, configure the hotkey to use
Ctrl-Alt-Shift instead of Ctrl-Alt.

Ctrl-Alt is used by Linux to access the virtual
consoles.

Complete the following:

Login to Linux

1. Boot the OES Linux server.

2. Login to the OES Linux server:
Username: admin

Password: novell
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Login, Use Linux, and Logout

Access the Virtual Consoles

1. Switch to the first virtual terminal by pressing
Ctrl+Alt+F1.

2. Login as admin with a password of novell.

3. Switch to the second virtual terminal by pressing
Ctrl+Alt+F2.

Notice that you are not logged in as admin.

4. Press Ctrl+Alt+F1 to switch back to the first
terminal.

Notice you are still logged in as admin.

Logout of Linux

1. From the first virtual terminal, logout by
entering: exit

2. Switch back to the graphical user interface by
pressing Ctrl+Alt+F7.

3. Logout of the graphical console.

a. Click on the KDE Menu (Green sphere with
red N).

b. Select Logout.
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Use the Linux Desktop (KDE)

1.

2.

10.

11.

12.

13.

Login as admin with a password of novell.

Click on the KDE Menu (Green sphere with red
N).

Select Internet.

Select Web Browser.

Select Mozilla.

Enter: localhost

You should now see the OES welcome page.

Close the browser.

Select the KDE Menu (Green sphere with red
N).

Select System.

Select YaST.

Enter the root password: novell
You should now see YaST.
Close YaST, select Close.

Start the file manager Konqueror by selecting
the blue house icon on the Kicker.
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14. View the navigation area by selecting the red
folder icon on the left side of the Konqueror
window.

(End of Exercise)

Version 1

Copying this document is strictly prohibited. To report suspected copying, please call 1-800-PIRATES. 2-5



Bridging NetWare to Novell Open Enterprise Server for Linux

Exercise 2 Locate and Use Help Resources

Use man pages

1.

2.

Launch a terminal (monitor icon with shell)

Find the man pages for the command info by
entering: whatis info

Read the first section (executable programs and
shell commands) of the man pages of the
command info by entering: man 1 info

Scroll through the text with the up arrow key and
down arrow key.

When you are finished reviewing the
information, press q to quit.

Use info

1.

Access the info page for the Is command, enter:
info Is

Move the cursor to Note Common options, press
Tab.

Go to the note by pressing Enter.

Return to the previous reference by pressing |
(lowercase L).
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Locate and Use Help Resources

5. Exit the info by pressing q.

Use the SUSE HelpCenter

1. Launch the GUI based help, select the lifesaver
icon on the kicker.

2. Create a search index by selecting the Search
tab.

3. Start the creation by selecting Yes.
4. Confirm the creation by selecting OK.
5. After the creation process finishes, press Close.

6. Get help about the Apache web server, enter
apache in the text field above the Search tab and
select Search.

7. Select the link for Chapter 22. The Apache Web
Server.

8. Afterreviewing the information, close the SUSE
HelpCenter window.

(End of Exercise)
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Exercise 3 Use the Linux Shell and
Command Line

Use the command history
1. Open a terminal.
2. View the history cache by entering history.

3. Press the up arrow key until you see a command
that you would like to execute, then press Enter.

4. Type h and press Page Up once.

You should see history displayed on the
command line.

Use the command line tab completion

1. From a terminal, change the current directory to:
letc

2. Use tab completion to display the contents of the
novell-release file, enter the following:

a. cat/no

b. Press Tab, the remainder of the filename
should display.

c. Press Enter.
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Use the Linux Shell and Command Line

You should see the contents of the file
novell-release displayed.

(End of Exercise)
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Exercise 4 Describe and Use Common Linux
Commands

Complete the following from a terminal:
1. Display your userid, enter:
whoami
2. Display the current directory, enter:
pwd

3. Change the current directory to /etc, enter: cd
letc

4. List the files in the directory, enter:

Is

v You can also use the dir command.

5. List the contents of the hosts file, enter:
cat hosts
6. Clear the screen, enter:

clear
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Describe and Use Common Linux Commands

v This is equivalent to the NetWare clear screen (cls). You
can also use Ctrl-1 (lowercase L) in Linux to clear the
terminal screen.

7. List the last 10 lines of the hosts file, enter:
tail hosts

8. List all configuration files under /etc, enter:

11 *.conf

v 11 is an alias for Is -I.

9. Change back to your home directory, enter:

cd ~

v You can also enter just cd without the tilde.

Display operating system information
1. Display the man page for uname, enter:
man uname

2. Look for the options to display the following:
o Kernel name

o Kernel release number
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4.

o Kernel version number

o Machine hardware name

Close the man page, enter q (for quit).

You can also use uname --help.

Display the above information using uname.

Create a directory and copy the hosts files from
letc

1.

From your home directory, create a directory
called backup, enter: mkdir backup

The command md also works.

Change to the backup directory, enter: cd
backup

Copy the files, enter cp /etc/hosts™ .

Using the dot for the current directory is equivalent to
using: cp /etc/hosts* /home/admin/backup

Verify the copy, enter: 1l

Now, copy the /var/log/ directories and all
subdirectories to /home/admin/backup, enter:
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Describe and Use Common Linux Commands

cp -r /var/log/ .

Verify that all the subdirectories below /var/log
were also copied.

Rename the hosts file to hosts.backup, enter:

cd ~/backup (make sure you are in the backup
directory under your home directory)

myv hosts hosts.backup

Create and Execute a Shell Script

1.

From the desktop, press Alt-F2.
Enter: kate

Enter the following to create a shell script that
will clear the display, display the current user,
and the date:

#!/bin/sh

# Script to clear the display, show the name of
current user logged in.

# Display today’s date
clear
echo "The Current User 1is: S$SUSER"

echo "Today is: ".date

Save the file as myscript.sh.
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5. Change the permissions to executable, enter:
chmod +x myscript.sh

6. Execute the script, enter: ./myscript.sh

You should see the terminal display clear and the
current user and date displayed.

(End of Exercise)
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Exercise 5 Understand and View Processes

Complete the following:

1.

2.

10.

11.

12.

13.

Open a terminal.

View all process with information on who owns
the process, enter: ps aux

View processes in real-time, enter: top
Press q to exit top.

View process graphically, enter: ksysguard
Select the Process Table tab.

Select the checkbox next to Tree to view the
process trees.

From the pull-down menu, select User
Processes.

Close ksysguard.
Start the program xeyes by entering: xeyes
Stop the process by pressing: Ctrl-Z

Move the xeyes process into the background by
entering: bg

Now, view the xeyes process information, enter:
ps aux | grep xeyes
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Vv

14.

15.

16.

17.

18.

ps aux displays all processes and then | (pipes) that
command to grep which searches the input from ps aux
for the string “xeyes” and returns just those processes
with that string.

Now end the process, enter: killall xeyes

killall can be used when you know the process name.
Otherwise, you can use kill with the process ID.

Now view all processes, enter: ps aux | less

Scroll through the output by pressing the Down
Arrow and Up Arrow keys.

Return to the command line by typing:

Close the terminal by entering: exit

(End of Exercise)
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Manage Runlevels

Exercise 6 Manage Runlevels

Complete the following:

1. From the KDE desktop, open a terminal
window; then su to root (su -) with a password of
novell.

2. Check the previous and current runlevels by
entering: runlevel

List the runlevels:

Notice that the previous runlevel is listed as N,
which means that there was no previous
runlevel set.

3. Change to runlevel 3 by entering: telinit 3

The KDE desktop (X windows) is terminated
and you are left at a terminal login prompt.

4. Log in as root with a password of novell.

5. Check the previous and current runlevel by
entering runlevel.

List the runlevels:
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6. Switch to runlevel 5 by entering init 5.
The GUI login screen appears.

7. Log in as admin with a password of novell.

(End of Exercise)
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Shut Down and Restart the Server

Exercise 7 Shut Down and Restart the
Server

Logout of the graphical desktop

1. From the N (KDE Menu), select L.ogout.
The xdm (graphical login) appears.

2. Select Menu (Alt-M).

3. Select Shutdown (Alt-S).

4. (Optional) Try additional methods of shutting
down the server, such as the following:

o shutdown -h now
o halt

o init0

o Ctrl-Alt-Del

5. (Optional) Try additional methods of restarting
the server, such as the following:

a2 shutdown -r now
o reboot
=) ll'llt 6

o Ctrl-Alt-Del

(End of Exercise)
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Module 3 - Novell Open
Enterprise Server for Linux
Features and Services

Exercise Manual

Complete the following exercises.

Exercise 1: OES Features and Services

Feedback
E-mail training @novell.com with the following:

Subject: Bridging NetWare to Linux Module 3
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Exercise 1 OES Features and Services

Complete the following:

1. What versions of NetWare and Linux are
included with Open Enterprise Server Support
Pack 1?

Why is this important to your deployment?

2. What OES services are not installed by default?

3. Determine the SUSE Linux release versions for
OES Linux. From a Terminal, enter:

cat /etc/SUSE-release
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OES Features and Services

4. OES Linux is the upgrade path for Nterprise
Linux Services 1.0 which includes: eDirectory,
iFolder, iPrint, eGuide, iManager, Virtual
Office, etc. Why is this important for OES
Linux?

5. List some of the services that were ported from
Linux to NetWare, so that administration on both
platforms can use similar tools.

Q

(End of Exercise)
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Answers to Exercise 1

1.

The following versions are included:
o NetWare 6.5 Support Pack 4

o SUSE LINUX Enterprise Server 9 Service
Pack 2

It is important to your deployment because you
are getting products that have already been
deployed in production environments for an
extended period of time and have been updated
to resolve common issues. This means that OES
i1s not a 1.0 product that you have to wait to
deploy.

OES Services not installed by default:

o Novell iFolder 2.x

o Novell NSS

o Novell Cluster Services

o Novell IP Managment (Framework only)

o Novell iFolder 3.x Web Access

o2 Novell 1Folder 3.x

You can find this information by launching
Yast. Select Software.

Select Install and remove software.
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OES Features and Services

Change the filter to Selections.
Scroll down in the left window pane.

3. The SUSE-release version is:
o SUSE LINUX Enterprise Server 9 (1586)
o VERSION =9
a PATCHLEVEL =2
4. It is important for OES Linux because it means

that these products have already been ported to
Linux and are not dot zero releases.

5. The newest product not in NNLS is NSS and
with Support Pack 1, the performance equals that
of NSS on NetWare.

6. Some services that were ported from Linux:

a bash

a2 vim

a rcd

a rpm

a ssh

o syslog
(End of Exercise)
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Module 4 - Install Novell Open

Enterprise Server for Linux

Exercise Manual

Complete the following exercises.
Exercise 1: Install OES Linux from CD
Optional exercises:

Exercise 2: Configure an NFS Network
Installation Server

Exercise 3: Install OES Linux from a Network
Installation Server Remotely via VNC

Feedback

E-mail training @novell.com with the following:

Subject: Bridging NetWare to Linux Module 4
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Exercise 1 Install OES Linux from CD

In this exercise, you will install Open Enterprise
Server on Linux from CD.

Setup Hardware

Complete the following:

1. Prepare the server that you are going to use to
install OES Linux.

2. Verify that the equipment you are using does not
contain any valuable data, as the hard drives will
be partitioned and formatted. This exercise
should only be performed on lab equipment and
not on a production server.

3. Verify the hardware meets the hardware
requirements for OES Linux.

4. The server that you install should be on an
1solated network. You will be using a 10.0.0.0
address. You can however choose any address
that works for your environment and then use
that address in the exercises instead of the one
listed.
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Install OES Linux from CD

Download OES Linux ISOs and Prepare CDs

If you do not have the OES Linux CDs available,
use the following instructions to create CDs.

1.

Browse to:
http://download.novell.com/

Select the Product pull-down menu and choose
Novell Open Enterprise Server.

Select Search.

Select the link for Novell Open Enterprise
Server SP1 EVAL.

Scroll down and read the information on this
page, as it will explain what each ISO files
purpose and how to label the CDs.

Under the evaluating OES with Support Pack 1
heading, select the link for Product
Registration and Access.

Record the Novell Open Enterprise Server for
SUSE LINUX Enterprise Server 9 Evaluation
Activation Code.

Select Proceed to Download.
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9.

10.

11.

12.

13.

14.

(Conditional) If you don’t have a username and
password for novell.com, select the link create
new account.

Login to your Novell Account by entering your
username and password.

Select Login.

Download the following files:
o oes-spl-linux-1.iso

o oes-spl-linux-2.iso

o oes-spl-linux-3.iso

o oes-spl-linux-5-sles9-2.1so
o oes-spl-linux-6-sles9-3.iso

o oes-spl-linux-7-sles9-4.iso

Optional ISO Images (containing source code):
oes-spl-linux-4.iso, oes-sp1-linux-8-sles9-5.iso,
oes-sp1-linux-9-sles9-6.iso

Review the Install Instructions, select view.

Verify the integrity of the downloaded ISOs.
You can check each file's MDS5 values by doing
one of the following:

From a Linux Desktop:
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Install OES Linux from CD

a. Open a shell prompt, enter the following
command:
mdSsum filename

where filename is the name of the file you are
verifying.

b. Compare the results with the MD5

Verification Numbers posted on the
download page.

From a Windows desktop:

a. Obtain a Windows-compatible MD5-based
checksum utility from the Web and follow the
usage instructions for the utility.

b. Compare the results with the MD5
Verification Numbers posted on the
download page.

15. Create the CDs:

a. Insert a blank, writable CD into your CD
burner.

b. Select the option to create a CD from an
image file.

c. Select ISO as the file type.

d. Select the first image file from the location
you downloaded it to.

e. Complete the CD creation process.
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f. Label the CD according to the Install
Instructions that you viewed earlier in this
lab.

g. Repeat this process for each of the ISO image
files.

Install OES Linux from CD

Hardware Requirements

In addition to the standard hardware
requirements, you will need 2 hard drives in the
server. The first will be used for the OES Linux
system and the second will be used for NSS.

If you do not have at least a 4 GB second drive,
refer to the OES documentation on how to
setup EVMS so that you can put both the Linux
system and NSS on the same physical hard
drive.

Do the following:

1.

Power on the computer that you are using to
install OES Linux.

Boot the server from the Open Enterprise Server
SP1CD 1.
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Install OES Linux from CD

3. When the GRUB installation screen appears,
highlight the Installation option and do NOT
press Enter.

You have 20 seconds to highlight the option
before GRUB boots from the hard drive.

4. Set the display resolution by pressing F2; then
select a display resolution of at least 1024x768.

v If a resolution of 1024x768 is not available, select the
highest resolution available (such as 640x480).

5. Verify the installation type next to F3 is set to
CD-ROM.

6. Verify that Installation is highlighted and press
Enter.

The Linux kernel begins loading.

A Novell Software License Agreement dialog
appears.

7. Accept the license agreement by selecting I
Agree.

A YaST Welcome screen appears. YaST is the
installation and system administration program
provided by SUSE LINUX.

8. Select English; then select Accept.
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v Or select the language of your choice.

9. (Conditional) If prompted to confirm driver
activation, select OK.

10. (Conditional) If a dialog appears with
installation options, continue by selecting New
installation; then select OK.

An Installation Settings screen appears with
several headings such as System, Mode,
Keyboard Layout, and Mouse.

Because this installation screen is designed in a
hub-and-spoke configuration, each heading
(headline) provides a link to a configuration
screen you can use to reconfigure the default
installation settings.

Make sure the System, Mode, Keyboard
Layout, and Mouse settings are correct (the
defaults are normally correct).

(Conditional) If a setting is not correct, select
the heading and make the necessary changes.

11. From the Installation Settings, scroll down and
select Time zone.

12. Select your time zone and then select Accept.
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Install OES Linux from CD

13.

14.

15.

16.

17.

18.

19.

Select Software.
Select Detailed Selection.

Select the following:
o Novell NSS

To utilize NSS on Linux, the server should have a second
hard drive with unpartitioned space.

Optional components that require additional
configuration that not covered in this training.

o DHCP and DNS Server

o Novell iFolder 2.x

o Novell Cluster Services

o Novell iFolder 3.x Web Access
o Novell iFolder 3.x

Select Accept.

From the Automatic changes screen, select
Continue.

(Conditional) If a setting is not correct, select the
heading and make the necessary changes.

When you are satisfied with the installation
settings, select Accept.
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20.

21,

22,

23.

24.

25.

26.

27.

28.

Start the installation by selecting Yes, install.
Wait for the files to be copied.

Insert the appropriate CDs when prompted.
After the last CD, the system to reboot.

Enter a root password of novell twice.

Accept the warnings about the password being
too simple. In a production environment, you
would want to choose a complex password.

Select Next.

From the Network Configuration screen, select
Change.

You may need to select Configure if the network card is
not listed in the bottom panel.

A list of one or more configured cards appears,
select Edit.

Select Static address setup and enter the
following settings:

o [P Address: 10.0.1.1
a2 Subnet mask: 255.0.0.0

Select Host name and name server and enter the
following:
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29.

30.

31.

32.

33.

34.

35.

36.

37.

o Host name: oeslinux
o Domain name: digitalairlines.com
o Name Server 1: 10.0.1.1

o Domain search 1: digitalairlines.com
When you finish, select OK.

Return to the Network cards configuration
overview by selecting Next.

Select Finish.
Select Next.

From the Test Internet Connection dialog, since
you are using an isolated network, select No,
Skip This Test; then select Next.

From the Service Configuration dialog, select
Next.

A Open Enterprise Server Configuration — Now
or Later dialog appears, select Next.

The eDirectory Configuration - New or existing
tree dialog appears. Leave New Tree selected
and enter the tree name: DA-TREE

Select Next.
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38.

39.

40.

41.

42.

43.

44.

45.

46.

47.

An eDirectory Configuration - Admin User and
Password dialog appears. Enter the following
information:

2o FDN admin name: cn=admin.o=da
a2 Admin Password: novell (twice)

Select Next.

An eDirectory Configuration - Ports dialog
appears. Accept the default values, select Next.

An eDirectory Configuration - NTP & SLP
dialog appears.

For the Network Time Protocol (NTP) Server &
SLP, accept the default for NTP as Local Clock
and since this is a small lab environment change
SLP to Use multicast to access SLLP; then select
Next.

From the warning about SLP, select Yes.
Select Next.

Select Next.

Select Next.

Wait while services are configured.

Review the release notes; then continue by
selecting Next.

4-12 Copying this document is strictly prohibited. To report suspected copying, please call 1-800-PIRATES. Version 1



Install OES Linux from CD

A Hardware Configuration screen appears.

48. Check the Graphics Cards information.

You should have a minimum resolution and
color setting of 1024x768 @ 16bit to run the
GUI interface for OES.

You can change the resolution and color setting
by doing the following:

a.

Select Graphics Cards.

If your monitor is not detected, a warning dialog
appears.

Configure your monitor by selecting Yes,
selecting Properties, and selecting the
monitor model or entering the correct
properties; then continue by selecting Finish.

On the left expand Desktop; then select
Color and Resolution.

At the bottom of the screen select Change
Configuration.

Make sure your desktop is selected; then
select Properties.

A dialog appears with tabs for Colors, Resolution,
and Expert.

Select Colors; then make sure 65536 (16 bit)
1s selected from the drop-down list.
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49.

50.

51.

52.

53.

g. Select Resolution (s); then select 1024x768.

h. When you finish, select Ok; then select
Finish.

i. Continue by selecting Finalize >>.

j. Test the new configuration by selecting Test.
A test screen appears.

k. (Conditional) If the display is corrupted or
does not display at all, press
Ctrl+Alt+Backspace and try adjusting the
colors and resolution again.

1. Make any position or size adjustments; then
select Save.

A message indicates that the settings have been
saved and will be displayed the next time you restart
the graphics system.

m. Select Ok.

Continue by selecting Next.

Continue by selecting Finish.

Log in as admin with a password of novell.

(Conditional) If you receive a warning message
about the monitor not reporting its X-size and
Y-size, continue by selecting No.

Test the installation by launching one of the
following from the web browser:
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o Welcome Page:
http://10.0.1.1/

o 1Manager 2.5:
https://10.0.1.1/nps/iManager

v The iManager URL is case sensitive.

o Novell Remote Manager:
http://10.0.1.1:8008

(End of Exercise)
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Exercise 2 Configure an NFS Network
Installation Server

In this lab, you will configure the server installed
in Exercise 1 as a network installation server.
Using that server, you can install other servers
from the network without shuffling CDs.

Configure NFS Server

1. From the OES Linux server desktop, launch
YaST.

2. Select Network Services.

3. Select NFS Server.

4. From the Configuration of the NFS Server
screen, select Start NFS server.

5. Select Next.

6. Select Finish.

Configure the Installation Server

1. Open a Terminal.
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10.

11.

12.

13.

Enter: su

Authenticate with root’s password that you set
during the installation of the server in Exercise 1.

Enter: c¢d /

Enter: md /install/oessp1

Launch YaST.

Select Misc.

Select Installation Server.

Select Configure as NFS Source

For the Directory, enter /install/oessp1
Select Next.

From the Installation Server -- NFS screen,
select Next.

Select Finish.

Extract the OES Linux ISOs

Do the following:

1.

Download netInstall.sh from

http://support.novell.com/cgi-bin/search/searcht
1d.cgi?/2972902.htm
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and save to the /install directory.

2. Copy the ISO files you downloaded to create
CDs in Exercise 1 to /install or burn them to a

DVD. You will need the following:

]

]

Q

]

]

Q

oes-spl-linux-1.iso
oes-spl-linux-2.iso
oes-sp1-linux-3.iso
oes-spl-linux-5-sles9-2.iso
oes-sp1-linux-6-sles9-3.iso

oes-sp1-linux-7-sles9-4.iso

From a Linux Desktop:

a.
b.

Open a terminal.

Change to the directory where the ISO files

were downloaded.

Enter the following command to copy the

files to the server:
scp * root@10.0.1.1:/install

This will copy everything in the directory (ISOs and
netlnstall.sh) to the /install directory on the server.

From a windows workstation:

a. (Conditional) Download a secure copy utility,

b.

such as PSCP.EXE (PuTTy).

Open a command prompt.
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c. Change to the directory where the ISO files
were downloaded.

d. Enter the following command to copy the
files to the server:

pscp * root@10.0.1.1:/install
Enter root’s password when prompted.

This will copy everything in the directory (ISOs and
netlnstall.sh) to the /install directory on the server.

3. Change the netlnstall.sh script to executable if it
is not already, using chmod +x netInstall.sh.

4. Run the network install script to extract the [SOs
to the NFS installation source.

J/netlInstall.sh
5. Enter the full path to the install source directory:
/install/oessp1

6. Enter the full path to directory containing ISO
files:

/install
or if you burned the ISOs to a DVD:
/media/dvd (or the path to your DVD drive)

(End of Exercise)
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Exercise 3 Install OES Linux from a Network
Installation Server Remotely via
VNC

In this exercise, you will install Open Enterprise
Server on Linux from an OES Linux installation
server.

In most cases you would use a SUSE Linux
Enterprise Server 9 installation server instead of
OES Linux, but for ease of use with this training,
the OES Linux server is being used.

The purpose of this lab is to simulate a system
administrator installing OES Linux on a server in
their data center.

Once the server is booted with the first OES CD
and the installation is started, the administrator can
go to their office and complete the installation
remotely.

Install OES Linux from a Network
Installation Source

Hardware Requirements
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In addition to the standard hardware
requirements, you will need 2 hard drives in the
server. The first will be used for the OES Linux
system and the second will be used for NSS.

If you do not have at least a 4 GB second drive,
refer to the OES documentation on how to
setup EVMS so that you can put both the Linux
system and NSS on the same physical hard
drive.

Do the following:

1.

Power on the Install Server and wait for it to
start.

Power on the server that is going to be installed.

Insert the Open Enterprise Server Linux
Installation CD 1.

(Conditional) If necessary, select the option to
boot from CD.

When the GRUB installation screen appears,
highlight the Installation option and do NOT
press Enter.

You have 20 seconds to highlight the option
before GRUB boots from the hard drive.
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6. Set the display resolution by pressing F2; then
select a display resolution of at least 1024x768.

v If a resolution of 1024x768 is not available, select the
highest resolution available (such as 640x480).

7. Set the installation type by pressing F3; then
select NFS.

8. From the HTTP Installation dialog, enter the
following:

o Server: 10.0.1.1
o Directory: /install/oessp1

9. In the Boot Options, enter:

vnc=1 vncpassword=novell hostip=10.0.1.2
netmask=255.0.0.0

10. Verify that Installation is highlighted and press
Enter.

The Linux kernel begins loading.

Wait until you see the message that the VNC
server is started.

11. Launch the VNC viewer from a Novell Linux
Desktop (workstation) by selecting Application
> System > Remote Access > Krdc or launch
VNC from a Windows workstation.
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12.

13.

14.

15.

16.

17.

For the Windows VNC client to connect, select Options
> Misc > Protocol 3.3.

Enter 10.0.1.2:1 and select Connect.
Enter the password: novell

A Novell Software License Agreement dialog
appears.

Accept the license agreement by selecting I
Agree.

A YaST Welcome screen appears. YaST is the
installation and system administration program
provided by SUSE LINUX.

Select English; then select Accept.

Or select the language of your choice.

(Conditional) If prompted to confirm driver
activation, select OK.

(Conditional) If a dialog appears with
installation options, continue by selecting New
installation; then select OK.
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18.

19.

20

21

22

23

24

An Installation Settings screen appears with
several headings such as System, Mode,
Keyboard Layout, and Mouse.

Because this installation screen is designed in a
hub-and-spoke configuration, each heading
(headline) provides a link to a configuration
screen you can use to reconfigure the default
installation settings.

Make sure the System, Mode, Keyboard
Layout, and Mouse settings are correct (the
defaults are normally correct).

(Conditional) If a setting is not correct, select the
heading and make the necessary changes.

From the Installation Settings, scroll down and
select Time zone.

Select your time zone and then select Accept.
Select Software.
Select Detailed Selection.

Select the following:
a  Novell NSS
o Novell iFolder 2.x

Select Accept.
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25.

26.

27.

28.

29.

30.

31.

32.

33.

From the Automatic changes screen, select
Continue.

(Conditional) If a setting is not correct, select the
heading and make the necessary changes.

When you are satisfied with the installation
settings, select Accept.

Start the installation by selecting Yes, install.

Wait for the files to be copied and the system to
reboot.

Enter a root password of novell twice.
Select Next.

From the Network Configuration screen, select
Change.

You may need to select Configure if the network card is
not listed in the bottom panel.

A list of one or more configured cards appears,
select Edit.

Select Static address setup and enter the
following settings:

o IP Address: 10.0.1.2
a2 Subnet mask: 255.0.0.0
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34.

35.

36.

37.

38.

39.

40.

41.

42,

43.

Select Host name and name server and enter the
following:

o Host name: oeslinux2
o Domain name: digitalairlines.com

o Name Server 1: 10.0.1.1

o Domain search 1: digitalairlines.com
When you finish, select OK.
Select Advanced > Virtual Aliases.

Select Add.

Create an Alias for iFolder, enter the following:
o Alias Name: iFolder

o IP Address: 10.0.1.3

o Netmask: 255.0.0.0

Select OK.

Return to the Network cards configuration
overview by selecting Next.

Select Finish.
Select Next.

From the Test Internet Connection dialog, select
No, Skip This Test; then select Next.
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44.

45.

46.

47.

48.

49.

50.

51.

52.

From the Service Configuration dialog, select
Next.

A Open Enterprise Server Configuration — Now
or Later dialog appears, select Next.

The eDirectory Configuration - New or existing
tree dialog appears. Leave New Tree selected
and enter the tree name: DA-TREE

Select Next.

An eDirectory Configuration - Admin User and
Password dialog appears. Enter the following
information:

o FDN admin name: cn=admin.o=da

a2 Admin Password: novell (twice)
Select Next.

An eDirectory Configuration - Ports dialog
appears. Accept the default values, select Next.

An eDirectory Configuration - NTP & SLP
dialog appears.

For the Network Time Protocol (NTP) Server &
SLP, accept the default for NTP as Local Clock
and change SLP to Use multicast to access
SLP; then select Next.

From the warning about SLP, select Yes.
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53. From the Installation Setting dialog, scroll down
and select iFolder 2.x.

54. Select Next.

55. Enter the following information:
o 1Folder 2.x server IP address: 10.0.1.3
o 1Folder 2.x server netmask: 255.0.0.0

o 1Folder 2.x server DNS hostname:
ifolder.digitalairlines.com

o 1Folder user data path: /var/ifolder2/data
56. Select Next.
57. Select Next.
58. Select Next.
59. Wait while services are configured.

60. Review the release notes; then continue by
selecting Next.

A Hardware Configuration screen appears.
61. Check the Graphics Cards information.

You should have a minimum resolution and
color setting of 1024x768 @ 16bit to run the
GUI interface for OES.

You can change the resolution and color setting
by doing the following:
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. Select Graphics Cards.

If your monitor is not detected, a warning dialog
appears.

. Configure your monitor by selecting Yes,

selecting Properties, and selecting the
monitor model or entering the correct
properties; then continue by selecting Finish.

. On the left expand Desktop; then select

Color and Resolution.

. At the bottom of the screen select Change

Configuration.

. Make sure your desktop is selected; then

select Properties.

A dialog appears with tabs for Colors, Resolution,
and Expert.

Select Colors; then make sure 65536 (16 bit)
is selected from the drop-down list.

. Select Resolution (s); then select 1024x768.
. When you finish, select Ok; then select

Finish.
Continue by selecting Finalize >>.

Test the new configuration by selecting Test.

A test screen appears.
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k. (Conditional) If the display is corrupted or
does not display at all, press
Ctrl+Alt+Backspace and try adjusting the
colors and resolution again.

1. Make any position or size adjustments; then
select Save.

A message indicates that the settings have been
saved and will be displayed the next time you restart
the graphics system.

m. Select Ok.
62. Continue by selecting Next.
63. Continue by selecting Finish.
64. Log in as admin with a password of novell.

65. (Conditional) If you receive a warning message
about the monitor not reporting its X-size and
Y-size, continue by selecting No.

66. Test the installation by launching one of the
following from the web browser:
2 Welcome Page:
http://10.0.1.2/
o iManager 2.5:
https://10.0.1.2/nps/iManager

v The iManager URL is case sensitive.
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o Novell Remote Manager:
http://10.0.1.2:8008

(End of Exercise)
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Module 5 - Open Enterprise
Server Administration

Exercise Manual

Complete the following exercises.

Exercise 1: OES Administration

Feedback

E-mail training @novell.com with the following:

Subject: Bridging NetWare to Linux Module 5
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Exercise 1 OES Administration

Complete the following:

1. How do the administrator accounts differ on
NetWare and Linux?

2. From a terminal, determine the runlevel, enter:
runlevel

3. How are services started on stopped on OES
Linux?

4. What is the Resource Control to restart Novell
Remote Manager for Linux?
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5. How do you provide updates to an OES Linux
server?

6. How do you apply a support pack to an OES
Linux server?

7. How do I check the status of eDirectory on
Linux?

a. From a Terminal, enter: ndsstat

b. Check the status with the resource control for
ndsd. First you need to switch user to root,
enter: su -

v Because the resource control can change the state of a process, you
have to switch user to root to perform the task.

c. Launch the ndsd resource control, enter:
rendsd status

d. Restart eDirectory on Linux, enter:
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rcndsd restart

Wait until you see eDirectory stop and start again.

(End of Exercise)

Answers to Exercise 1

1. The root account on Linux is local, while the
admin account on NetWare is in eDirectory.

You can login to the OES Linux server as
admin, however it is just a regular user. The
root account is the all power account. The user
root has a User ID (UID) of 0 (zero).

2. You should be in runlevel 5 for these exercises.

3. /etc/init.d/servicename start | status | restart |
etc...

4. rcnovell-httpstkd restart

5. You can update an OES Linux server using the
rug command line client.

You will need an activation code discussed in
the Exercises of Module 4.

Novell’s update server is:

https://update.novell.com/data
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7.

8.

Check the OES Linux Installation Guide on
www.novell.com/documentation for details.
The section titled, Patching a Server using the
ZLM Channel from the Command Line (rug).

To apply a support pack, check the OES Linux
Installation Guide on
www.novell.com/documentation for details. The
section titled, Patching an OES Linux Server,
provides a variety of methods.

For example, this course uses a non-routable
private address and so using the method of
patching the server using a patch CD would
work.

n/a

n/a

(End of Exercise)
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Module 6 - Manage the
Network

Exercise Manual

Complete the following exercises.
Exercise 1: Configure Network Boards
Exercise 2: Manage Network Boards

Exercise 3: Determine Network Connectivity

Feedback

E-mail training @novell.com with the following:

Subject: Bridging NetWare to Linux Module 6
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Exercise 1 Configure Network Boards

Depending on the utility, you will see a Network
Board referred to by various terms:

network board = network interface card (NIC) =
network card = network board = ethernet device =
net interface

Complete the following:

1. Open a Terminal.

2. Switch user to root, enter: su -

3. Enter root’s password.

4. Display the IP Address, enter: ip address show

5. Now display the network interface
configuration, enter: ifconfig

6. You can also view and configure network boards
using a GUI. From the OES Linux Desktop,
select the YaST icon.

v You can also launch YaST from the N (KDE Menu) >
System > YaST.
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v TIP: From the desktop, if the mouse pointer changes
from an arrow to a pointing hand, only a single click is
required to launch the icon. YaST also utilizes single
clicks, however does not change the mouse pointer.

7. Enter root’s password.
8. Single click Network Devices.
9. Single click Network Card.

The Network card configuration window
appears.

There are two sections.

o The top section displays network cards that
are not configured.

o The bottom section displays network cards
that are already configured.

v TIP: In the top section, you need to highlight the
unconfigured device and then choose Configure. In the
bottom section, you cannot highlight the device, but just
select Change and then you will be taken to a list of
devices that you can change.

10. Select Change.
11. Highlight the top interface card and select Edit.
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12. Familiarize yourself with how to configure IP
Address and Subnet Mask.

v TIP: With OES Linux, if you change the IP Address, you
will need to change the IP Address in the services
configuration files that refer to it. The presentation
portion of this course contains the TID number for the
document that provides details on how to do this.

13. Select Host name and name server.

The Host name and name server configuration
appear.

14. The Host Name field contains the name of the
server. The default value is linux. The name
server fields also contain the IP Address and
Domain for the DNS servers. Select OK.

15. Select Routing.
16. Review the options and select OK.

17. To add a Secondary IP Address, select
Advanced.

18. Select Virtual Aliases.
19. Select Add.
20. For the Alias Name, enter: www

21. For the IP Address, enter: 10.0.1.10
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22. For the Netmask, enter: 255.0.0.0
23. Select OK.

24. Select OK.

25. Select Next.

26. Select Finish.

(End of Exercise)
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Exercise 2 Manage Network Boards

Complete the following:

1.

YaST stores the configuration information in
/etc/sysconfig/network. Change to this directory,
enter: cd /etc/sysconfig/metwork

List the directory, enter: 1l

Display the adapter you just configured. The file
will begin with ifcfg-eth-id-<MAC address>.
Enter: cat ifcfg-eth-id

Now press Tab to complete the rest of the
filename, which is the MAC address of your
network board.

Press Enter.

Review the output for the Secondary IP Address
that you just added.

If you have the need to restart all network boards
on the server, there 1s no need to reboot the
server like some operating system, you can enter
the following: rcnetwork restart
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v You will find that as you build your skill set on Linux that
the tendency to reboot to fix a problem will go away.
Restarting a reconfigured or failed service usually
resolves the issue on Linux.

6. To deactivate a single network board, such as
eth(, you can enter: ifdown eth(

7. To activate ethO, enter: ifup eth(

(End of Exercise)
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Exercise 3 Determine Network Connectivity

Complete the following:

1.

2.

Open a Terminal.

Enter: ping -¢3 10.0.1.10

You can also configure the newly added secondary IP
Address with a DNS entry and ping it by name, but that
is beyond the scope of this course.

Now enter: ping 10.0.1.10

You will notice that the default behavior is to
continue to ping the device. This is helpful when
you want to troubleshoot a device that is not
responding and view the ping results to see if the
problem has been resolved. To stop the
command, enter: Ctrl-C

Now let’s look at listening network connections
and statistics, enter: netstat

You may have noticed a lot of information
scrolled by, therefore it is helpful to pipe the
output of netstat to the less command. Enter:
netstat | less

Scroll through the output with arrow and page
keys. To quit, press Q.
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10.

11.

12.

To display network routes, enter: netstat -r
Now switch user to root, enter: su -
Enter root’s password.

You can check connectivity across multiple
routers with the traceroute command.

However, if you isolated your server on a
private network as specified in this training, you
can just try the command: traceroute 10.0.1.1
to some how the output is formatted.

You will want to try this command on a your
network to see more meaningful information.

Lookup the man pages for the following
commands and test them out on a network that
has DNS setup:

o arp

Q dlg

(End of Exercise)
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Module 7 - Server Management
Tools

Exercise Manual

Complete the following exercises.

Exercise 1: Use Novell Remote Manager for
Linux

Exercise 2: Configure iManager 2.5 on Linux
Exercise 3: Use iManager 2.5 on Linux

Exercise 4: Access the OES Linux Server via SSH

Feedback
E-mail training @novell.com with the following:

Subject: Bridging NetWare to Linux Module 7

Version 1

Copying this document is strictly prohibited. To report suspected copying, please call 1-800-PIRATES. 7-1



Bridging NetWare to Novell Open Enterprise Server for Linux

Exercise 1 Use Novell Remote Manager for
Linux

Typically the tools discussed in this section are
access from a workstation. If you do not have a
workstation attached to the same network as the
OES Linux server, you can launch the Mozilla
browser from the server.

Complete the following:

1. Open a browser from a workstation or from the
server, select N (KDE Menu) > Internet > Web
Browser > Mozilla.

v If you do not have the server patched with Support Pack
1, you will need to update Mozilla to version 1.7 or
install Firefox.

2. Launch Novell Remote Manager, enter the
following URL:

http://10.0.1.1:8008
or
https://10.0.1.1:8009

3. (Conditional) Accept the certificate permanently
if prompted.
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10.

11.

12.

13.

(Conditional) If prompted with a DNS security
error, since we are not running a DNS server for
this course, select OK.

(Conditional) Select the option you want and OK
to any other encryption alerts that may appear.

Login as admin with a password of novell.

(Conditional) If prompted to remember the
password, it is up to you what option to choose.
Obviously, you would never remember
passwords for a production server because of the
security risk.

From the main screen, familiarize yourself with
the File System Mounts.

Expand Diagnose by select the plus icon to the
left.

The collapsible menu items are a new feature in OES
SP1.

Select Health Monitor.
Review the health items listed.
Expand View File System from the left menu.

Select View File System Listing.
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14.

15.

16.

17.

18.

19.

You will notice that the root file system is
displayed on the right.

Select etc.

Scroll down and observe the icons on the left of
the file listing. Directories are designated with a
yellow folder and document icon. Files are
designated with just a document icon.

You may notice that both icons also have a
magnifying glass as part of the icon, indicating
that if you select the icon, you can see more
information about that file.

Choose any file in the list and click on the icon.
Scroll down and review the information.

Notice that you can set Linux file permissions,
edit, delete, and rename the file.

You can also create hard and symbolic links
(the discussion of what these links are is outside
the scope of this course).

Now, expand Manage Hardware and
familiarize yourself with the information that
you can select.

The Use Group Operations allows you to setup

a visual map of your server and monitor their
health.
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20. The Manage NCP Services section allows you
to manage NCP volumes.

v Module 8 will discuss NCP server.

21. Now, familiarize yourself with the icons at the
top of the page.

22. When you are done, select the exit icon.

(End of Exercise)
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Exercise 2 Configure iManager 2.5 on Linux

Do the following:

1.

Open a web browser and enter the following:
https://10.0.1.1/nps/iManager

Authenticate as admin with a password of
novell in the DA-TREE.

If you get a -634 error, just enter the IP Address of the
server instead of the treename.

Notice the following information on the main
screen:

o admin.da has unrestricted access

o Some of the roles and tasks are not
available

Select View Details.

View the tasks that are not available, then select
Close.

Select the Configure icon.
Expand Role Based Services.
Select RBS Configuration.

Select Configure iManager.
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10.

11.

12.

13.

14.

15.

Set the Container field to da.
Select Next.

Verify that all modules are selected and then
browse and set the scope to .DA-TREE.

Leave the Assign Rights and Inheritable boxes
checked.

Select Start.
When the modules are updated, select Close.

Now that RBS is configured, admin.da will
have Collection Owner Access and the
informational message about the tasks not being
available will have been resolved.

(End of Exercise)
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Exercise 3 Use iManager 2.5 on Linux

Do the following:

Modify the Helpdesk Role

Do the following:

1.

Launch iManager by entering the following in a
web browser:

https://10.0.1.1/nps/iManager

Authenticate as admin.

Scroll down and expand the Users role.

Select Create User.

Enter the following:

]

]

Q

]

]

Username = geeko
Lastname = novell
Context = da

Password = novell

Retype password = novell

Select OK > OK.

Select the Configure icon at the top.

Expand Role Based Services.
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10.

11.

12,

13.

14.

15.

16.

17.

18.

19.

20.

21.

22,

23.

24.

25.

Select RBS Configuration.

Select Role Base Services 2.da.

Select Help Desk.

Select Add in the title bar at the top of the list.
From All Tasks, select ModifyGroup.

Select the right arrow to move the task to
Assigned Tasks.

Select OK > OK.

Select Close.

Select the checkbox next to Help Desk.
Select Actions > Member Associations.

For the Name field, select the Object Selector
icon; then browse to and select geeko.da.

Select OK.

For the scope field, select the Object Selector
icon; then browse to and select da.

Select OK.
Select Add.
Select OK > OK.

At the top of the screen, select the Exit icon.
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26. Log in as geeko with a password of novell.

Notice that only the Helpdesk role is available
to EKing.

27. Select the Exit icon.

Create iManager Favorites

Add 4 tasks that you perform on a regular basis to
the Favorites:

1.

2.

Log in as admin with a novell password.

At the top of the screen, select the Favorites
icon.

No favorites should be listed.
Select the Preferences icon.
Under General, select Manage Favorites.

Add the following tasks to the Favorites list (use
the left arrow):

a Create User
a  Modify User
a  Set Password

o Volumes

Select OK > OK.
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7.

Select the Favorites icon.

The 4 tasks you selected should now be listed
under Favorites.

(Optional) Change the Language to one you are
familiar with, view the changes, and then set
back to English.

Search for eDirectory Objects Using iManager 2.5

Do the following:

1.

2.

Select the View Objects icon.
Select the Search tab.
In the name field, enter SSL* and select Search.

You should see SSL certificate objects for both
oeslinux and oesnw.

Start a new search, in the Name field, enter k*
and select Search.

In the Type field, select User.

All users with a user id that begins with K are
displayed.
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Customize iManager Look and Feel

Do the following:

1.

Select the Configure icon.

2. Expand iManager Server.

3. Select Configure iManager.

4. Select the Look and feel tab.

5. Change the Title Bar Name to your company’s
name.

6. Change the Header Color to #6484A4.

7. Change the Background Color to #B6C9CEF.

8. Select Save.

9. Select Roles and Tasks to view the new look
and feel.
If the Title has not changed, try reloading the
web page.

(End of Exercise)
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Exercise 4 Access the OES Linux Server via

SSH

This exercise works best from a Linux or Windows
workstation.

If you use a Windows workstation, you will need
to download an SSH client, such as PuTTy and
adapt the exercise appropriately to the client you
are using.

If a workstation is not available, you can still
perform the exercise on the server to simulate
access from a workstation.

Complete the following:
1. Open a Terminal.
2. Enter: ssh root@10.0.1.1

3. (Conditional) If prompted to add the local IP
Address to the list of known hosts, enter: yes

4. Enter the password: novell

You are now connected to the server as if you
were sitting at the server console.

Notice the prompt in the terminal changes to
indicate the name of the server.
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5. To end the ssh session, enter: exit

6. Close the terminal, enter: exit

(End of Exercise)
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Module 8 - Manage the File
System

Exercise Manual

Complete the following exercises.

Exercise 1: Use the Linux File System
Exercise 2: Understand Disk Partitions
Exercise 3: Use NSS on Linux

Exercise 4: Use NCP Server and File Access

Exercise 5: Use Samba for Native Windows
Access to OES Linux

Feedback
E-mail training @novell.com with the following:

Subject: Bridging NetWare to Linux Module 8
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Exercise 1 Use the Linux File System

Complete the following:

1.

2.

10.

Open a Terminal.
Create a file, enter: touch myfile.txt

List the files in the directory that begin with m,
enter: Il m*

Notice that a file called myfile.txt was created.
Update the timestamp on the file, enter:
touch myfile.txt

List the files in the directory that begin with m,
enter: Il m*

Compare the information listed.

Switch user to root, enter: su -

Enter root’s password: novell

Change back to admin’s home directory, enter:
cd /home/admin

Now change the ownership of the file, enter:
chown root myfile.txt

List the files in the directory that begin with m,
enter: Il m*
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11.

12.

13.

14.

Notice the change of ownership.
Rename the file to first.sh, enter:
mv myfile.txt first.sh

List the files in the directory that begin with f,
enter: Il f*

Notice the file name has changed.
Now change the file to be executable, enter:
chmod +x first.sh

List the files in the directory that begin with f,
enter: Il f*

Notice the execute permission has been added.

(End of Exercise)
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Exercise 2 Understand Disk Partitions

Complete the following:

1. View the partitions and mountpoints that are
automatically mounted at boot time, enter:

cat /etc/fstab
2. View mounted file systems, enter:
mount

3. A helpful command to determine how much disk
space is free, is the df command. Enter:

df -h

v The -h displays the information in human readable, such
as KB, MB, or GB.

4. Determine disk usage with the du command.
Enter: du -sh

v The -s is used to provide only summary information. The
-h displays in human readable format.

(End of Exercise)
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Exercise 3 Use NSS on Linux

Requirements

This lab requires two hard drives on the server or
virtual machine you are using to perform the
exercises.

Complete the following:

1.

2.

Open a Terminal on the OES Linux server.
Switch user to root, enter: su -

Enter root’s password: novell

Launch the NSS Management Utility, enter:
nssmu

The NSS Management Utility main menu
appears. You will notice that this is identical to
nssmu on NetWare.

Select Devices.

Write down the device name for the second hard
drive you have installed in the server.

Version 1

Copying this document is strictly prohibited. To report suspected copying, please call 1-800-PIRATES. 8-5



Bridging NetWare to Novell Open Enterprise Server for Linux

7. Press Esc.
8. Select Pools.
9. Press Insert and create a pool named linuxpool.

10. With the device name that contains free space
highlighted, press Enter.

11. Enter a partition size in MB of 1000, press
Enter.

12. Press Esc.
13. Select Volumes.

14. Press Ins and create a volume named linuxvol,
press Enter.

15. From the pool list, select linuxpool.

16. Press Esc (twice) to exit nssmu.

17. From the Terminal, enter: nsscon

18. The NSS console will appear, enter: nss space

19. To close the console, enter: exit

v You can create another NSS volume in iManager by
following the same steps you use to create an NSS volume
on NetWare.

(End of Exercise)
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Exercise 4 Use NCP Server and File Access

Requirements

This exercise requires Windows workstation
running the Novell Client for Windows.

Complete the following:

1.

2.

Open a Terminal.

Switch user to root, enter: su -

Enter root’s password: novell

Change to the / (root) directory, enter: cd /

Create a directory named mail, enter: mkdir
data

Create an NCP volume using ncpcon, enter:
ncpcon

Enter: volumes
Enter the following command:
create volume data /data

From a Windows workstation, right-click the red
N in the system tray, then select NetWare
Login.

The Novell Client for Windows dialog appears.
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10.

11.

12.

13.

14.

15.

16.

Select Advanced.

Make sure the following is entered in the
displayed fields:

a Tree: DA-TREE
o Context: da

o Server: oeslinux or 10.0.1.1
Log in as admin with a novell password.

From the desktop, open My Network Places and
select Novell connections.

Locate the oeslinux server and confirm that it has
the volumes SYS and DATA mounted.

Open DATA and create a folder called project
and a folder called reports.

Grant the user geeko.da, the RWCEMF rights by
doing the following:

a. Right-click the project folder.
b. Select Trustee Rights.

Browse to and select geeko.da.
d. Select Add.

e. In the Trustee list at the top, select the W, E,
C, and M boxes.

f. Select OK.

o
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17.

18.

19.

20.

21.

22,

g. Close all windows.

Right-click on the red N in the system tray and
login as .geeko.da with a novell password.

A Confirm dialog appears.
Select Yes.

From the desktop, open My Network Places and
select Novell connections.

Locate the OESLINUX server and confirm that
it has the volumes SYS and DATA mounted.

Open the DATA volume and confirm that you
can see only the project folder.

Close all open windows on both computers.

(End of Exercise)
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Exercise 5 Use Samba for Native Windows
Access to OES Linux

Create a public access SMB share on your OES
Linux server and access it from a Windows
workstation without using the Novell Client for
Windows. You can also setup controlled access
shares.

Using iManager you can also enable eDirectory
users to access Samba on OES Linux.

Complete the following:

1.

From a Windows workstation initial login
prompt, make sure Workstation only is selected
if the workstation has the Novell Client for
Windows installed; then log locally to Windows.

From the OESLINUX server desktop, open a
terminal window.

Switch to root by entering su - and a password of
novell.

Create a new directory to function as the share by
entering mkdir /sambademo.

Make this share available to all users by entering
chmod 777 /sambademo.

8-10 Copying this document is strictly prohibited. To report suspected copying, please call 1-800-PIRATES. Version 1



Use Samba for Native Windows Access to OES Linux

10.

From the desktop, press Alt+F2; then enter
kdesu kate; then select Run.

Enter a password of novell and select OK.

Select File > Open; then browse to and open the
/etc/samba/smb.conf file.

You can increase the size of the text in the file by
selecting the plus magnifying glass icon on the toolbar.

Note the name of the Samba server in the file.
The netbios name should be %h-W. The %h
variable expands to the oeslinux hostname, so
the Samba server name is oeslinux-W.

Add the following lines to the end of the file:
[sambademo]
comment = OES Samba Public Share
path = /sambademo
read only = no
public = yes
Save the file by selecting File > Save.

Keep the smb.conf file opened, as you will edit
it later.
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11. From the terminal window, restart the Samba
server by entering:

rcsmb restart

v You can also enter: /etc/init.d/smb restart

12. On your Windows XP workstation, select Start
> Run.

13. Enter the path:
\\oeslinux-W
14. Select OK.
15. Verify that you can see the sambademo share.
16. Create a new file in the share.

17. From the terminal window on the OESLINUX
server enter:

cd /sambademao ; Is -1

Notice that the file you created is owned by the
user nobody.

This is the Linux user that public samba access
maps to.

(End of Exercise)
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Module 9 - Monitor the
Operating System

Exercise Manual

Complete the following exercises.
Exercise 1: Monitor Processes on Linux
Exercise 2: Monitor Connections
Exercise 3: Monitor Server Health
Exercise 4: Monitor the Server

Exercise 5: Access Error Logs

Feedback

E-mail training @novell.com with the following:

Subject: Bridging NetWare to Linux Module 9
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Exercise 1

Monitor Processes on Linux

Complete the following:

1.

2.

Open a Terminal.

List the processes that are running on the OES
Linux server, enter: ps aux

Now look for process information for ndsd,
enter:

ps aux | grep ndsd

To view real-time process information, enter:
top

Review the process information and when done,
close top, enter: q

You can view a process and it’s associated
process, enter: pstree

Using the ps aux command, find the process id
(PID) and then display the process tree. For
example: pstree 7034

To view process information in a graphical
utility, launch: ksysguard
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9.

Familiarize yourself with the available options
for processes, select the Process Table tab.

(End of Exercise)

Exercise 2

Monitor Connections

Complete the following:

1.

2.

9.

Open a Terminal.

Create a file, enter: touch testfile
Edit the file, enter: kate testfile
Enter some text into the file.

Now check to see what processes are using that
file, enter: fuser -v /home/admin

Now check for open files, enter:

Isof | less

When done viewing the list, enter:

Now check to see who has testfile open, enter:
Isof | grep testfile

Save the file testfile and exit kate.

10. Monitor the connections, enter:
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11.

12.

13.

14.

15.

w
Also try the command who, enter: who

Now create another connection to the server,
enter:

ssh root@localhost
Authenticate using root’s password.

Now, display connection information again,
enter: w

Close all terminals.

(End of Exercise)
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Exercise 3 Monitor Server Health

Complete the following:

1.

Open a web browser and enter the following:
https://10.0.1.1/nps/iManager

Log in as admin with a novell password.
From the left pane, expand Servers.

Select Monitor Servers.

Browse to and select da as the container; then
select OK.

Select Add.

o Server Name: oeslinux

o IP Address/DNS Name: 10.0.1.1
o Description: OES Linux

Leave the default Monitoring Type set to:
o Robust Health (OpenWBEM required)

Select OK.

Select the link for oeslinux and view the server
health information.

10. Select Servers (from the main frame).
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11.

12.

13.

14.

15.

16.

17.

18.

19.

20.

21.

Select the description OES Linux and view the
Quick Status.

Select Action > Manage Groups.
Select Add.

For the Group Name, enter Linux Servers; then
select OK.

Select the Linux Servers group link.
Select Add.
In the Server Name field, enter:

oeslinux

In the IP Address/DNS Name field enter:
10.0.1.1

Select OK.
Select Groups.

Notice that you now have 2 groups
available—Linux Servers and My Servers. The
Linux Servers group only includes Linux
servers, while the My Servers group can
include other servers.

From the Groups screen, select MyServers.
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22. (Conditional) If you have workstation or any
device with an IP address, find the IP address of
that device.

For example, if you have an Novell Linux
Desktop workstation:

a. Open a terminal.

b. Enter: su

c. Enter: root’s password

d. Enter: ifconfig

e. Write down the IP address of ethO:

23. Select Add.
a2  Server Name: NLD

o IP Address/DNS Name: enter IP address
Jrom the step above

o Description: Workstation
24. Change the Monitoring Type to:

o Simple Server Status (up/down status only)

25. Select OK.
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26. Select the Show Status Icon Legend icon
(located in the upper right corner of the screen)
and review the legend.

27. Take some time to review other Health Monitor
options.

(End of Exercise)
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Exercise 4 Monitor the Server

Complete the following:
1. Open a Terminal.
2. View memory usage, enter: free

3. Determine how long the server has been up,
enter: update

4. Display CPU information, enter:
cat /proc/cpuinfo
5. Display system information, enter:

procinfo

(End of Exercise)
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Exercise 5 Access Error Logs

Complete the following:

1.

2.

Open a Terminal.

View the system error logs, enter:
cat /var/log/messages

Look for a specific string, enter:
cat /var/log/messages | grep string
View kernel message, press:
Ctrl-Alt-F10

Press Enter a few times to create some space on
the screen.

Toggle back to the GUI, enter: Ctrl-Alt-F7

From a terminal, generate an error message,
enter: ssh root@10.0.1.1

For the password, enter: wrong
View kernel message, press:
Ctrl-Alt-F10

Notice the error message generated.
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10.

11.

12.

13.

14.

15.

16.

Now view the system log in YaST, select the
YaST icon from the desktop or from the N (KDE
Menu).

Authenticate with root’s password.
Select Misc.
Select View system Log.

From the pull-down menu, select some of the
other logs.

When done viewing the log, select OK.
Select Close.

(End of Exercise)
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Module 10 - Linux Training
Plan

Exercise Manual

Complete the following exercise.

Exercise 1: Create a Linux Training Plan

Feedback

E-mail training @novell.com with the following:

Subject: Bridging NetWare to Linux Module 10
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Exercise 1

Create a Linux Training Plan

Complete the following:

1.

I! m)l

Complete this course, Bridging NetWare Skills to
Novell Open Enterprise Server for Linux.

Pass the course assessment.

Find a mentor that 1s a Linux veteran that 1s
willing to patiently give you guidance when you
need it.

Read, How To Ask Questions The Smart Way

http://www.catb.org/~esr/faqs/smart-questions.html

Based on any unanswered questions that you
have from this training, do all you can to find the
answers to a questions before asking someone.

This 1s a great way to discover and learn.

If you have searched and cannot find an answer,
go to your mentor before you get frustrated.

Complete the Novell Linux Desktop (NLD)
Training, then install and use NLD. Free through
March 2006.
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l! m\‘

l! m\‘

10.

11.

12.

13.

14.

http://www.novell.com/training/train_product/Ilcm/lcm.html

Install SUSE Linux 9.3/10, or Open SUSE
Linux.

Use both KDE and gnome interfaces and
applications.

Try some of the lab projects for OES Linux.

http//www.novell.com/products/openenterpriseserver/docs/oes_migr
ation.pdf

Visit the websites listed in the course.

Review some of the books listed on the Novell
Press website and talk to your mentor for advice
on other books and resources they found helpful.

Determine your learning style.

Based on your learning style, there are additional
training resources available for instructor-led
training, self-paced, etc., determine the level of
certification that you need.

Review the Certified Linux Professional (CLP)
information.
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15. Review the Certified Linux Engineer 9 (CLE9)
information.

http://www.novell.com/training/certinfo/cle9/
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16. Determine if you need additional training on
Open Enterprise Server, such as course 3059.

http://www.novell.com/training/train_product/oes.html
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17. Determine if you need additional training on
eDirectory on Linux, such as course 3017.

http://www.novell.com/training/train_product/nds_edirectory.html
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If you need additional assistance with your training plan
or want custom/onsite training, please contact Novell
Training Services.
http://www.novell.com/training/pep/custom_training.ht
ml
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(End of Exercise)
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